1. Create a folder in the H: drive or other safe location and name it GIMP
2. Save eight or more images intended for this project in the GIMP folder.
3. Open GIMP by choosing Start | All Programs | GIMP | GIMP2
4. When the following window appears, close the tip menu, unless you want to get
some basic fips.
5. The following windows are important to create your masterpieces:
The GIMP This window
v I window is | &P 0B B Geeted L HhacOMES
ltl [ipe ] (& ool options Shift+Cerl+T .
a very 4 16 oo st available when
y s B/ important fiahvevsl an | | you choose File |
48207 & 069 window. || i New from the
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_- o | you click 1 - access windows
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— . 1 ", Colors .
Mode: | Normal (i OppeOr N | & Brushes Shift+Ctrl+8 TOSkS, C“Ck on
BYUSh: Circle(ll) ‘.-‘-_->->----_->->--’ ------- ‘-‘---- 6’ Patterns Shift+Ctrl+P H
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[7] Fade out @ Fonts
[] Incremental hclf Of !ﬂ:] Buffers Choose your
[] use color from gradient The | Images WlndOW.
, > Document Histor:
window. |D i
: 2 -@ <& Tools
!ﬁ\ Error Console
Let’s Begin!

6. Create a blank canvas to create your masterpiece by choosing File | New from

the main menu.

7. When the following window appears, type in 500 X 500 pixels for the dimensions.
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8. Save the new window by choosing File | Save As from the main menu.
9. When the following window appears, type in collage in the Name section as
shown below.

MName: |Follage
Saveinfolder: | [&} HP_PavILION (C:\) vl

[+ Browse for other Folders

[+ Select File Type (By Extension)

l Cancel ] [ Save ]

10.To place the collage in the gimp folder, click on the Browse for other folders option
and locate the gimp folder. In order to open and edit this collage in GIMP, save it
as collage.xdf. Note that the file chosen was GIMP XCF image (*.xdf) If saved with
the xdf extension, you will be able to open it in GIMP. Without an extension, you
won't be able to save.

Name: collage. xcf| Tln.
D . .
o i s You will be able to insert your
final image production .in’ro
— — e word documents, welbsites,
DHP_Administl Dcnllage.xcf Today eTC. When yOU SOVG IT OS O
DDeskl:op H
B . paviiol JPEE? or GIF.. To con’n.nue
& He_RecovEl| - editing the image with layers
B ey . . .
B ry in GIMP, continue to save it
g:j: with an xdf extension.
& S
] @) Examples:
GIMP XCF image (*.xcF) v
[+ Select File Type (By Extension) . H .
collage xdf; pic.xdf; dog.xdf
[ Cancel l l Save I
11.0nce the blank canvas is saved, you can open up the images you previously
saved in the gimp folder. 1
12.You might want to temporarily paint the background since a g v 20
. . . 54
painted background helps determine the boundaries on the : o &«
canvas. [—_|| .
13.Click on Tools | Paint Tools | Bucket Fill or click on the Paint Bucket prerond s badgrond ol T
icon in -I-he GIMP WindOW. iclitooplenthecnlorjelfcti?ndflo
14.Pick a solid temporary color by clicking on the FG color fill under Fill [+ " |
. . ill Type <Ctrl
Type and double clicking on the Foreground & background colors e
icon to access colors. SR

15.0nce you have a solid color, click on the canvas and it will be painted.
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16.To open images, choose File | Open from the canvas menu.
Navigate to the gimp folder and select the images. To select more than one
image, hold down the control key. Once the images are selected, click on the
Open button.

Now, that is

] ““Open Image ‘X’

a lovely
i - Creature!
Places v Modified Preview
[ He_administ ears.jng o |
D Desktop
B Hp_paviLIOl
[ He_RECOVEI =
e | ]
By B o
B ey | ] walrus.jpg
B Hy  E 54.0KB
- 800 x 640 pixels
B [ ] pa RGE, 1 Layer
P ()
T ‘ [ >t . wolf.jpg
= |alFiles ‘XI

i+ Select File Type {Automatically Detected)

Help [ Cancel ] I Open l

Let's put images on the collage!

17.7To select part of the image in order to copy it and paste it on the collage, choose
Tools | Selection Tools | (Select from the tool that will best suit your needs )

iB) 1 layer) 900x434 .
Image Layer B Dislogs  Filters Script-Fu The fO”OWIﬂg eXCImp|e Used The %
o [0, Teolex I k0 F i Intelligent Scissors. (1) using the
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% Swap Colors
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"""" = image continuously unfil the entire

[ Selection Tools [ 5 Rect select
d Swctamrods | EbsoSolect selection || image is selected. (2) Click
G m f::s'ltt choices anywhere after the selection to
& Color icker O | O gycoorske  shiteo [0 make the selection complete. (3)
.: . R wotenesesrs 1| Provide a feather effect by choosing

Select | Feather and click OK

T _Tevt I

The feather
could be set
before the
selection.

Feather selection by

b: pixels l v U

_______ i s [ Help ” Cancel JI OK l
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If the selection doesn’t occur, select the layer in the Layer’s window and
hit the Enter key on the keyboard. If the Layer’'s window isn’t showing,
choose Dialogue | Layers in the menu of the image you are selecting.

18.0nce the selection is made, you can choose Edit | Copy in order to copy the
selection.

19.0pen or access the collage canvas and choose Edit | Paste from the menu.

20.Since the image pasted is taking up the maijority of the collage canvas, it needs to
be resized to roughly 200 pixels wide. See number 19.

21.Choose Layer | Scale Layer from the menu. Click on the drop down arrow of the
Width option and set it to roughly 200 pixels. The Height should adjust accordingly,
so don't worry about adjusting it if it changes as you adjust the Width.

1 Scale Layer - .- Scale Layer
q‘ Floating Selection amm R‘ Floating Sele?tion =7

(Pasted Layen)-112 (Untitled) (Pasted Layer)-112 (Untitled)

Scale Layer

Layer Size Layer Size
width: | T & width: | po1 =
Height: | 501 3‘@3@!5 v Height: | 245 Cg pixels \V\
;g6d;i501 pixels ;gld ;i248 pixels

22.The following is an example of before and after resizing the layer.
A

[
@

R e S B e ]

px ]| 100% [ [Pasted Layer (6.21 vE) ]

23.To move the image, make sure you are on the correct layer. Select the Move tool O-I-’

from the GIMP window and move your image.

24.Continue getting the other images by using the selection tool of your choice. You
can click on the selection tools in the Tools window (known as The GIMP) or choose
Tools | Selection Tools | (selection)

(il Top half of voce: [ B ] Bottom half
E.ﬂj)f;s ;D \ EE 113@ Datoow wlndow [¥] Feather edges /\\';[aOF tOOIS
RZOA® shows the ks 3 0o |8 window

t0oOlS. [] Auto shrink selection shows
BRBAET el 5 options
GO0 20« ' associated
g & o6 o & Ll with that
* ° L& & t00|.
s | | mm
Rect Select = ®
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25.Before copying and pasting a selection, make sure your Layer’s Window is showing.
If the Layers window isn't showing, choose Dialogue | Layers from the menu of the
collage. (1) The window will look something like the following example. (2) When
you choose Edit | Paste, the Layers window will have added a layer that says,
“Floating Selection (Pasted Layer) (3) When you hit the Enter Key on the keyboard
a couple of times while on the Floating Layer, it will show the Walrus. (4) Rename
the layer, by double clicking on the layer and typing in an appropriate name.

ode:

Opacity:

Normal

@

D] ¢

D Background

s @ v (8 |LOJ ¢ | @

D Background

Floating Selection
Pasted Layer)

D Background

@ [ ](.8]

(OJ ¢ [olld] v (8]

D Background

(O0J ¢ [olla)] ¢ (8]

26.You can resize the recently copied image by repeating steps 18 and 19. The width
and height will vary depending on the image being resized. In the walrus example,
the width was set to roughly 400 pixels wide. It all depends on what effects you

want.

Examples of different selection tools: Tip, set the feather edges

Feather edges
Radius: j

I’N]

100 |3

before

using the following selection tools. This becomes available in the GIMP window when
you click on the selection tool. Setting the feather gives softer edges around the
selected image. Drag the selection tools around the part of the image you want to
copy. Once it is selected, choose Edit | Copy from the main menu or Ctrl + C

Rec Select Ellipse Select Free Gelect

Jconh | reees :é @

Steps Choose Tools | Choose Tools | Choose Tools |
Selection Tools | Rect Selection Tools | Ellipse | Selection Tools | Free
Select from the main Select from the main Select from the main
menu. You can also menu. You can also menu. You can also
click on the on the icon | click on the on the icon | click on the on the icon
of the GIMP window. of the GIMP window. of the GIMP window.

TResults
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Adding a Background with Gradient Effects

27.The following steps show how to use the Gradient tool to create a background. (1)
Make sure you have selected the background layer. If the Layer's window isn't
showing, choose Dialog | Layers from the menu. (2) Select the Gradient tool in the
Tools Window (3) Click on the gradient options to get a variety of choices. (4)
Change the shape of the gradient if you choose.

Background [ayer

Gradients Tool

Gradient Qptions

Layers

Mode: | Mormal

Opacity:

(KD

[OJ e

File ¥tns

Help

Wi P A

1O

Opacity:
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Gradient: ]

Offset: FG to BG (HSY clockw —
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Shape:
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|
8 I m l \X: l 9 I @ E T & { Abstract 3
Possible Gradients Possible Gradients Example of Gradient
Gradients = ® E]] Burning Paper
Burning Transparency
m FG to BG (HSY counter-clockwise) .] Caribbean Blues
s toBa (Rag) [ e
- FG to Transparent |:| CD Half
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Using the Shape option
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shape
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Mode:
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Adding a Background with Paint Bucket Fill

28.The following steps show how to use the Paint Bucket tool to create a background.
(1) Make sure you have selected the background layer. If the Layer’s window isn't
showing, choose Dialog | Layers from the menu. (2) Select the Paint Bucket tool in
the GIMP Window (3) Click on the Foreground & Background options in the GIMP
window to get a solid color or (4) Click on the Pattern fill option to get a variety of
patterns to fill the background. The bubble of the Pattern fill needs to be selected
or you won't be able to access patterns.

Background [ayer

Paint Bucket Tool|

Paint Bucket Options

Layers

Mode:

Mormal

ayers o+

N =
V\Dﬁ

100.0

|
B |
Opacity: J

Bucket Fill

Opacity:

Mode: Mormal

Fill Type <Ctrl>
() FaG color Fill

(O BG color Fill
(%) Pattern fill

Pine

Possible Fills

Possible Fills

Example of Fill

m Parque #3 (64 x 64)
- Pastel Stuff {64 x 64)

Pine {64 x 56)

Pine? (100 x 100)

: : Pool Bottom (45 x 45)

Pink Marble (128 x 128)

=
|

. 3D Green (45 x 45)
- Amethyst (64 x 64)
. Big Blue {45 x 45)
. Blue Grid (25 x 25)
Blue Squares (160 x 100)
- Blue Web {64 x 64)

Cork board (78 x 43)
. Crack (144 x 144)
- Craters (115 x 115)

Dried mud (100 x 100)
. Electric Blue (80 x 40)

Crinkled Paper (128 x 128]

Example of Fill

Example of Fill

Example of Fill
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Adding Text

29.To add text, (1) select the Text tool in the GIMP window. (2) Change the Font Style,
(3) Font Size, (4) and Font Color

Text = =

Font: |A& |Sans

q Joze: 18 Lr;‘:‘ px ‘:
m f p A I Hinting
@ @ B [E ‘E D [] Force auto-hinter

Antialiasing

GO /I 720« @cw::]

1]

a & 6 ﬁj ‘ Justify: ,
- @ = Indent: 0.0 & |
o li Line 0 0 J,N E
.J—l FEmEa spacing: .~ o) =1y

30.Click down on your canvas and (1) a window will appear for you to type in the text.
(2) As you type in the window, you will be able to see if you like the font size, style
and color. (3) You can make changes before accepting the text, by changing the
color, font style and font size in the GIMP window.

QIN
e

Liry Gothic v 12 -

B % |lw %
Open Clear || LTR | RTL 0
Protect Wildife

Size: 70 pine marten
Hinting

["] Force auto-hinter
Antialiasing

[ mep | gose

Tools Dialogs Filters Script-Fu

Justify: @
i findent: :UtU
m I;Q:cing:iroior
y 8 s o oy .

31.1f the text is beneath other layers, simply drag it and drop it on top of the other
layers in the Layer’s window.

Layers @ & Layers = &

Mode: | Normal iv_\ & Mode: | Mormal Lv_‘ D

Opacity: — — 1| 1000 |5 Opacity: a 100.0 |
> & Protect Wildlife I
B | eagle l
B wolf

walrus

E Protect Wildlife @

© Chris Clementi 2007 Clipart from [Microsoft and photographs from Geek Philosopher




32.1f you want to apply unique effects to the text, make sure you are on the Text Layer
that you want to modify. Click on the drop down arrow of the Mode option in the

Layer's window and experiment with your choices. The default is Normal.

Layers =X

Layers E ®
voce: | MOoms
Opacity: | Dissolve 3| 1000 |5
Multiply
LN Divide ptect Wildlife
Screen =
N Overlay gle
Dodge ‘
& Burn il
Hard light
@& Soft light s
Grain extract ™
v
| Grain merge | =7 S - —

Normal is
over-rated!

33. If you want to apply filter effects to the text, make sure you are on the Text Layer
that you want to modify. Right click on the text of your collage and select Filters.

File »
Edit »
Select »
View »
Image »
Layer »
Tools »
Dialogs »

] & Repeat "FlareFx"

&) Reset all Filters. ..

Blur

Colars

Noise
Edge-Detect
Enhance
Generic
Glass Effects
Light Effects

Chrl+F
> | 8% Re-show "FlareFx" Shift+Ctrl+F

v v v vvwvwvw

here are several filters
to choose from.
Experiment! If you don’t
like the results, simply
choose Edit | Undo or
click on the Ctrl + Z keys.
Keep in mind that you
can apply the filter
effect fo images as well.
That is probably more
common.

34.The following example used Filter | Distort | Wind. It is important to experiment with

the options in these windows to get the desired results.

[ | )_\
Preview
Style Direction Edge Affected

O wWind @) Left O Leading

() Blast O Right O Trailing
Threshold: I 16 ‘;'
Strength:  —_| 3 :i‘

. Help I Cancel l l OK I

1 heed
protection!
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Fading images by changing the opacity of a layer.

35.Choose a layer to fade. In this case, the Layer’'s window was accessed and the

tiger layer was selected.

Layers &=
‘ i
Mode: | Mormal ‘ ﬂ\ o
. [1ona |
Opacity: ] | 100.0 i

<& . pine marten

Layers

= ®
Mode: ’ Normal E‘ =

Opacity: :}

i)
EXNS

- pine marken

— sl

37.Click on the layer you want to apply a filter effect.
38.Right click on the image on the collage window and choose Filter | (Choose from

a wide range of choices)

36.Locate Opacity and move the leverage unfil you are satisfied with the results of the
transformation. In the example, the opacity was changed to 50%.

Filter | Artistic | Cartoon

Filter | Map | Paper Tile

Filter | Distorts | Wind

7 . N |
| £t

—

Filter | Distorts | Emboss
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39.Make sure you save your collage with the layers before preparing it for other
applications.

40.Choose File | Save As from the collage window.

41.Locate the folder you want to save the image

42.Select the File Type. In this case, since it is a photo intended for a website or word
document, choose JPEG image which will add the .jpg extension to your collage.
Clipart is usually saved as a GIF

“"Save Image

Name: collage.jpg
Save in folder: D Gimp e
i+ Browse for other folders

=l Select File Type (JPEG image)

£

File Type Extensions |

@ GIMP brush gbr

& GIMP brush {animated) gih

0, GIMP pattern pat ‘
qgzip archive xcf.gz,gz,: \ i
HTML table htel, htm

JPEG image JPg,iped; i
KIS5 CEL cel

43.1f the following window pops up, choose Export, since your image needs to be
flattened.

(. Xport File ]

= Your image should be exported before it can

\ z ’ be saved as JPEG for the following reasons:

JPEG can't handle transparency

I'minto

Flatten Image

The export conversion won 't modify
your original image.

l Help J [ Ignore I I Cancel I I Export l

44, When the following window pops up, unless you understand the specifications of
quality, leave the default settings and choose OK.

Q_uality is
important!

Quality: : g—iiss &

[ show Preview in image window

+ Advanced Options

Help Cancel oK
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All Images on collage are from Geek Philosopher, a Public Domain site
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